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1. Probe Description 

1a. Spyne scanner 

Bending curvature: 150 mm (6 in.) OD to flat 

Maximum temperature of operation: 150 °C (300 °F) 

Maximum probe speed: 1200 mm/s (48 in/s)  

Mechanical features: 

1. Detachable, high-precision encoder (25.87 count/mm) 

2. Holder slots for coverage markers 

3. Silicone wheels, easily swappable with magnetic wheels 

4. Detachable handles 

5. Central attachment to the Spyne eddy current array (ECA) probe 

6. Detachable keypad and circumferential encoder 

7. Temperature-resistant cable sleeve 

 

 

Figure 1. Spyne scanner features 
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Spyne keypad 

The Spyne keypad can be used to facilitate the acquisition. Note that the F1 button is only active 

when using an Ectane 3 and is not associated to any action on Reddy. 

 

 

NB. The Pause button will only function when the circumferential encoder is activated in the 

setup. Otherwise, it will act as a “Next Pass” button. 
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1b. Spyne probes 

Probe characteristics: 

ECA-SPYNE… -C-202-250-086 -C-203-025-066 -D-200-250-066 

Material to inspect Ferromagnetic Ferromagnetic, 

Non-ferromagnetic 
(subsurface defects) 

Non-ferromagnetic 

(surface defects) 

Topology Long, single driver Long, single driver Short, double driver 

Coverage 202 mm (8.0 in.) 203 mm (8.0 in.) 200 mm (7.9 in.) 

Coil size 4.5 mm 6.0 mm 6.0 mm 

Number of coils 86 66 66 

Number of channels 126 127 128 

Defect orientation All orientations (cracks, pitting, etc.) 

Max T° of operation 150 °C (300 °F) 

Probe features: 

1. High-density connectors to the Spyne scanner 

2. Central attachment point to the Spyne scanner 

3. Memory Integrated Circuit (memory IC) for pre-uniformization data storage 

4. PEEK tape for wear protection, thickness 0.25 mm (0.010 in.) 

 
Figure 2. Spyne probe features 
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1c. Spyne scanner accessories  

 

Pointers attached to the 

front and back of the 

probe, to help following 

the pre-drawn scan 

lines 

 

 

 

 

Ten replacement PEEK layers (thickness 0.25 mm, 

0.010 in.) for the protection of the Spyne probes. 

Always make sure to replace the PEEK layer on the 

probe before the PCB itself gets damaged. More 

layers can be purchased directly from Eddyfi. 

 

 

Curve-Lock for inspection of pipes with dents and 
large areas of generalized corrosion. Easy installation 
and removal with thumb screws. 

 
  

Aluminum tool for 

functionality check 

(see section 5 of this 

user guide) 

 

Set of 16 magnetic wheels for the inspection of 

ferromagnetic surfaces, available as an option 

with the Spyne scanner. Easily swappable with the 

standard silicone wheels. 
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1d. Spyne probe replacement 

One advantage of the Spyne is the possibility to use different probes with the same scanner. For 

example, a single Spyne scanner can be used to inspect both ferromagnetic and non-

ferromagnetic materials simply by swapping the probes, which takes less than a minute: 
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2. Pipe preparation and scan plan definition 

2a. Number of passes 

Depending on the pipe circumference, a given number of passes will be required to scan the 

whole pipe circumference. The required number of passes can be calculated with this formula: 

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑎𝑠𝑠𝑒𝑠 =  
𝑃𝑖𝑝𝑒 𝑐𝑖𝑟𝑐𝑢𝑚𝑓𝑒𝑟𝑒𝑛𝑐𝑒

𝑃𝑟𝑜𝑏𝑒 𝑐𝑜𝑣𝑒𝑟𝑎𝑔𝑒 − 𝑂𝑣𝑒𝑟𝑙𝑎𝑝
 

• The pipe circumference should be measured with a measuring tape and not calculated 

from the nominal OD. This avoids positional errors. 

• The probe coverage depends on the probe model that is used. Refer to section 0 to know 

more about the different Spyne probes. 

• An overlap of 12.5 mm (0.5 in.) is recommended. 

Make sure to always round up to the nearest number of passes (ex. for 10.1 passes, round up to 

11). 

2b. Scan zones definition 

The number of scans required to cover a certain length of pipe is limited by the file size that 

Magnifi can handle.  

• To cover the full 360° of a pipe in a single data file, the table below helps to evaluate the 

maximum axial scan length allowed, based on the pipe diameter. The values are based on 

the recommended 12.5 mm (0.5 in.) overlap between each pass, with an axial resolution 

of 1 sample per millimeter. Warnings will appear in Magnifi if the entered scan length 

exceeds the values mentioned below. 

Pipe outside 
diameter 

Number of 
passes for 
full 360° 
coverage 

Circumferential scan size 
with recommended 12.5 
mm (0.5 in.) overlap (Y) 

Maximum axial scan length 
(X) for full 360° coverage in a 

single data file* 

6” 3 570 mm (22 in) 20.8 m (800 in) 

8” 4 760 mm (30 in) 17.0 m (650 in) 

10” 5 950 mm (37 in) 12.3 m (475 in) 

12” 6 1140 mm (45 in) 10.2 m (400 in) 

16” 7 1330 mm (52 in) 7.6 m (275 in) 

20” 9 1710 mm (67 in) 6.0 m (225 in) 

24” 11 2090 mm (82 in) 4.9 m (175 in) 
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30” 13 2470 mm (97 in) 3.9 m (150 in) 

36” 16 3040 mm (120 in) 3.2 m (125 in) 

42” 18 3420 mm (135 in) 2.7 m (100 in) 

48” 21 3990 mm (157 in) 2 m (80 in) 

*Values for scans using the circumferential encoder. 

2c. Pipe marking 

Some reference points should be defined and marked on the pipe when preparing it to be 

scanned: 

I)  Circumferential datum 

 The circumferential origin is typically set on top of the pipe, at 0° (12 o’clock). A chalk line 
or measuring tape can be used to draw the 0° line along the whole length of the pipe. 
During the first scan, the pointers at the top of the Spyne should be aligned with this line. 

II) Scan lines 

Chalk lines may be drawn before beginning the inspection to ensure a proper coverage of 
the pipe. 

The coverage indicators on the sides of the probe show the start and end of the sensitive 
area. The pointer should be aligned with the beginning of the probe coverage. Note that 
the pointer should be adjusted only after setting the Spyne to the correct curvature.  

 

Figure 3. Example of circumferential datum and scan lines on a pipe. 
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Figure 4. Four indicators of coverage on the Spyne probes. 

III) Reference axial datum 

The reference axial datum corresponds to the X = 0 position. It is the reference based on 
which the axial start line is set. It is recommended to use the nearest upstream girth weld 
as the X = 0 position. 

IV) Axial start line (NDE start) 

For pipes, the scan direction is typically oriented with the flow. If the upstream girth weld 
is exposed on the pipe, the axial start line should be at 150 mm from it, since the Spynetool 
is 150 mm wide along the scan axis. This way, when the Spynetool is placed on the pipe, 
the back wheels will touch the girth weld, and the front wheels will be at the axial start line. 

If no upstream girth weld is present on the pipe, the axial start line should be drawn at least 
150 mm away from the end of the coating. 

V) Axial end line (NDE end) 

The axial end line can be defined based on the maximum scan length allowed by Magnifi. 
Depending on the pipe circumference, Magnifi will warn the operator if it inputs a scan 
length longer than this maximum. Refer to the table in section 2b for the maximum scan 
length for each pipe diameter. 

It is important to note that, when performing a scan with the Spyne, the back wheels should 
always pass this line completely at the end of each scan pass: 

 



 

12 | P a g e  

 

Figure 5. Examples of positions of the axial reference datum (upstream girth weld), axial start line (NDE 
start), and axial end line (NDE end) on a pipeline with multiple scan zones.  

 

Figure 6. Pointers attached to the front and back of the probe and aligned with the beginning of the 
coverage. 

An overlap must be set between each scan line in order not to miss any potential indication. 

As a general guidance, we recommend setting this overlap to 12.5 mm (0.5 in.). 

Thus, the distance between two scan lines should be approximately 190 mm (7.5 in.) 
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3. Data management (Inspection List) 

The terms backstage and frontstage used in this guide refer to the two main windows of Magnifi. 

To switch between the backstage and frontstage, click on the triangle icon at the top left of the 

screen:   . The backstage is displayed at the opening of Magnifi and contains the options 

related to the inspection, data management and general preferences. The frontstage is the main 

window for acquisition and analysis.  

This section suggests a convenient way to manage and save automatically large numbers of data 

files during an inspection. The following steps can be done in advance in Magnifi, before getting 

to the inspection site. 

I)  In the backstage of Magnifi, in the Inspection menu, select a project folder and an 

inspection folder . 

II)  In the Acquisition menu, select the Prefix filename option. 

III)  Click Create New List. 

IV)  Select the prefix for the files name, the number of elements (i.e. data files) in the list, the 
index for the first data file and the index increment between each file. The example below 
shows an example of list based on the following parameters:

Selected parameters: Resulting list of data files:

Prefix: SCC 

Number of elements: 4 

Element start number: 10 

Element increment: 2 

 

Prefix Index 

SCC 010 

SCC 012 

SCC 014 

SCC 016 

V)  Click Create. 

VI)  Switch to the frontstage by clicking on the triangle  in the top left corner of the screen. If 
this is a new inspection, the acquisition summary window will immediately pop up and ask 
for information relative to the current inspection (component type, client, service provider, 
etc.). This information can be modified later through the Acquisition summary tab in the 
backstage. 

VII)    In the frontstage, in the Layout tab, make sure the Data  button is checked. The list 
of data files will be displayed on the left side of the screen. 
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VIII)  When an acquisition is stopped, these two options will allow to automatically save the data 
file and select the next one in the list. The next acquisition can then be started immediately, 
without any other action required. 

IX)  If an Ectane is being used, connect to the instrument by clicking Connect       in the 
Instrument tab. 

X)     Once the setup parameters and preferences are settled, uncheck Setup Mode  in the 
Home menu. Otherwise, in setup mode, no data will be saved automatically. 

XI)  In the list of data files, select the first file to be acquired. The inspection can begin. 

A few more information about data management in Magnifi: 

o The small icon beside each data file indicates its current state: 

Icon Definition 

 The data file has not been acquired yet (empty file) 

 The data file was acquired and saved 

   The data file is tagged for review 

 The data file was reported free of indications 

 Indications have been reported in the data file (2 indications) 

 

For more information on data analysis, refer to section 7 of this user guide. 

o At any time during the inspection, the user can click Add data  or Delete data  

at the bottom of the list of data files. Data files added with this button will keep the 

same prefix. 

o To re-scan a data file that has already been acquired and saved, select the data file 

and click Re-scan . 
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4. Setup creation 

4a. Preparing the setup 

To prepare a setup for a Spyne inspection, click on New → Spyne Setup from the Setup tab in the 

top ribbon. A description of all the adjustable setup parameters is provided in section 4b. 

  

   

 

 

 

The Spyne is available with cable lengths of 5, 10, or 15 meters (16.4, 32.8 or 49.2 feet). This is 

specified in the setup name (N05, N10, N15). 

All Spynetool scanners purchased after August 21st 2024 come with a circumferential encoder, 

ensuring that both the axial and circumferential positions are recorded in a single scan. To take 

full advantage of the circumferential encoder, it is necessary to use Magnifi 5.4. In this release, 

when creating or selecting a new setup, two options will appear: Circ-Enc and No-Circ-Enc. To 

enable the circumferential encoder during your scans, select the setup starting with Circ-Enc.  
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All Spyne probes are pre-uniformized to ensure a uniform response of all their channels, without 

the need to bring a large calibration plate to each inspection site. This pre-uniformization is 

embedded in the probes and cannot be disabled. It is also specific to each probe and thus 

unrelated to the setup being used. In other words, swapping the Spyne probe in the middle of an 

inspection will have no effect on data collection: the instrument will always apply a pre-

uniformization that is specific to the probe currently connected. 

More information on the pre-calibration process can be found in the datasheet provided with 

the probe. 

4b. Setup parameters 

The Spyne setup wizard will guide the user through 5 steps, which can also be accessed 

individually from the Setup tab: 

 

Scan definition: Configuration of the scan parameters: 

o Scan type (single pass or multi-pass) 

o Position  

o Acquisition type (clock-based, single encoder or dual encoder (axial and 

circumferential) 

o Probe speed, acquisition density and acquisition frequency 

o Size of the scanned area (see section 2c) 

 

Data definition: Fine-tuning of the hardware electrical parameters (injected current’s 

frequency, amplitude and phase, hardware gain). It is not recommended to modify 

these parameters. 

 

Data processing: Adjustment of the C-scan filters: 

o Low-pass filter: used to remove high-frequency signals caused by a poor surface 

condition, vibrations, electronic noise, etc. A longer window size will provide a 

more aggressive filter. 

o High-pass median filter: used to remove low-frequency signals caused by large 

areas of corrosion, lift-off, changes of magnetic permeability, etc. A shorter 

window size will provide a more aggressive filter. See section 8 for more details 

on how to use the high-pass median filter. 
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Indication codes: Managing the different types of indication codes used for the 

indications that are added manually to the report. 

 

 

Display: Configuration of the display options during and after acquisition. 

 

 

4c. Scan definition window 

The default scan parameters in Magnifi 5.4 are the following: 

 

Figure 7. Default scan parameters for the probe ECA-SPYNE-C-202-250-086. 

o The Scan Type menu allows switching between single pass scans and multi-pass scans. 

o Position From allows switching between time-based (clock), single encoder, or dual 
encoder-based acquisition. 

o Pattern: In Multi Pass mode with the circumferential encoder, the scan pattern can be 
selected between Unidirectional (Comb) or Alternating (Raster). 
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o Density corresponds to the axial resolution (the number of data points acquired per 
unit of axial distance). 

o Typical and Maximum Probe Speed are based on the user’s preferences. 

 

Depending on whether you are using the Spyne circumferential encoder or not, the following two 
sections describe what scan parameters are required to enter in the scan definition window. 

 

A. Scans with circumferential encoder 
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o Pipe Circumference: it is strongly recommended to measure the actual pipe circumference 
with a flexible measuring tape. This maximizes the positional accuracy of the 
circumferential encoder. 

o The Start Line and End Line represent the position of the axial start and end lines with 
respect to the reference datum. For example, if the start line is at 150 mm (6 in) from the 
reference datum, the value to be entered in the Start field would be 150 mm (6 in). Refer 
to section 2 for further information on how to define these values. 

o If multiple datafiles are created, the Start Line should correspond to the end position of 
the previous scan. 

 

B. Scans without circumferential encoder 

 

o The Encoder Preset at the bottom of the screen represents the position of the axial datum 
line relatively to what is considered to be the X = 0 position. For pipelines, the X = 0 
reference usually corresponds to the upstream girth weld. For tank walls inspected 
vertically, the X = 0 could be either the floor or ceiling, depending on the scan direction. 

o The Offset refers to the axial (X) and circumferential (Y) start position of the C-scan. Since 
the Spyne sensors are located approximately 75 mm (3 in) behind the front of the scanner, 
data is always being recorded 75 mm before the datum reference. If this additional data 
is of no interest to the user, the Offset should be set equal to the Encoder Preset to avoid 
displaying it in the C-scan. Otherwise, if the operator is interested to find potential crack 
indications immediately behind the datum line, the Offset should be set 75 mm (3 in) 
before the Encoder Preset, as it is set by default. 

o The Size corresponds to the axial (X) and circumferential (Y, only adjustable for multi-pass 
scans) length of the C-scan. It should consider the actual scan length and the selected 
Offset. It is good practice to use a Size value slightly longer than strictly necessary, to avoid 
missing data in case the scan length ends up being slightly longer than planned. Refer to 
section 2 for further information on how to define these values. 
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Figure 8. In this example, the Spyne 
inspection (NDE) begins 30” past the 
upstream girth weld: the Encoder Preset is 
thus set to 30”. Assuming that the operator 
is interested to display the data recorded by 
the sensors behind the start line, the Offset 
is set 3 inches before the Encoder Preset, at 
27”. Finally, since the C-scan needs to 
display all data between 27” and 126”, the 
Size needs to be set to at least 99”. 

 

4d. Setup layout 

1. Axial C-Scan: Visualization of axial indications of crack colonies. In the example below, four 
axial crack colonies were automatically detected and localized with yellow boxes in the C-
scan.  

2. Axial Lissajous: Impedance plane for the data points within the axial C-scan cursor. In the 
example below, the red horizontal line represents the signal threshold for automatic 
detection. Because the signal of the indication inside the cursor gets above this line, an 
indication box is automatically added in the axial C-scan. 

3. Transverse C-Scan: Visualization of transverse (circumferential) indications of crack 
colonies. In the example below, no transverse crack was detected. 

4. Transverse Lissajous: Impedance plane for the data points within the transverse C-scan 
cursor. Since the signal of the indication inside the cursor does not get above this line, no 
indication box is added in the transverse C-scan. 
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Figure 9. Spyne setup layout for acquisition and analysis 

 

To display only a single C-scan, switch to the alternative layout display, under the Select menu of 

the Layout tab. 

To change the settings of any of these windows, first select it to highlight its outline in orange, 

and go to the Current View tab. To switch a C-scan view between axial and transverse data, click 

on the A or T in the top left corner of the window. 

4e. Detection gates adjustment 

The Spyne is a high-resolution detection tool that can detect millimeter-sized cracks in a large 

variety of materials. Depending on the application, this can lead to hundreds of indications 

detected during a single scan. 

To facilitate the efficient reporting of large numbers of indications, a lot of efforts have been put 

into Magnifi toward the automatic detection of defects. By default, this automatic detection is 

based on a vertical signal threshold: indications with a vertical signal amplitude higher than the 

threshold will be automatically marked in the C-scan.  

The user should keep in mind that the signal amplitude is not affected only by the depth of the 

defects. The length, width, orientation, and density of the defects will all affect the signal. For 

this reason, the Spyne cannot be used for accurate depth measurement. 

In the default Spyne setup, the signal threshold is set to 0.50 V. For the probes operating in single 

driver (for ferromagnetic materials), this corresponds to the signal of an isolated 3 mm X 1 mm 

(0.120” X 0.040”) crack. For the probes operating in double driver (for non-ferromagnetic 
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materials), it corresponds to an isolated 2 mm X 1 mm (0.080” X 0.040”) crack. Note that these 

numbers are approximate and will highly depend on the material type, its magnetic permeability, 

the geometry of the surface, the level of corrosion, and the amount of lift-off. For this reason, 

the signal threshold should be fine-tuned with a representative calibration sample containing the 

smallest defect that needs to be detected. 

To adjust the alarm threshold by using a calibration sample with a target defect: 

I)  Null the probe on a clean section of the calibration sample. 

II) Start an acquisition and scan the target defect. 

III) Move the C-scan cursor on the target defect in the C-scan corresponding to the orientation 
of the defect (axial or transverse). Locate the channel displaying the highest vertical 
amplitude by using the up and down arrows while keeping an eye on the corresponding 
Lissajous window. 

IV)  Use either of the following methods to adjust the signal threshold to the desired level of 
sensitivity: 

a. Select the corresponding Lissajous window (axial or transverse) and enable the Edit Alarm         
button      in the Current View tab. Drag the red horizontal line in the Lissajous to 
approximately 75% of the maximum amplitude. 

b. With the amplitude measurement set to Absolute Peak Vertical (“Vapv” at the bottom 
left corner of the Lissajous window), note the signal amplitude of the target defect. Open 
the Detect Indication window (located in the Setup tab on Reddy, and in the Advanced tab 
on Ectane, see Figure 11) and adjust the corresponding threshold (axial or transverse) at 
75% of the measured value. 

 

Figure 10. Example of a proper adjustment of the automatic detection signal threshold, using a calibration 

sample with a single axial defect. 

Cursor centered on target defect 

Signal threshold set to 75% of the 

defect’s signal tip 
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Figure 11. The Detect Indications window offers the following options; Label: indication name displayed 

in the C-scans and in the report; Based on: for Spyne and ECA in general, the detection is always based on 

the C-scans; Source: name of the C-scan associated to the detection; Zone type and Zone details: 

conditions for automatic detection – by default, a simple vertical threshold is used. Boundary: distance 

criteria for merging nearby indications. 

VI) Re-scan the target defect multiple times to ensure that it is always detected automatically. 
A yellow box will appear around the indication in the C-scan. 

VII)  If necessary, repeat steps II through VI for the second C-scan (axial or transverse) by 
scanning the same defect with a 90° angle shift. 

4f. Save the inspection setup 

To save the inspection setup, follow the procedure below: 

1. Go to the Backstage by clicking on the orange arrow at the top left of the screen  

2. Go to the Save tab and click on Save Setup As: 
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3. Name your setup and click on Save. 
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5. Calibration check 

At the beginning and end of an inspection, it is good practice to verify that every channel of the 

probe is operating properly, to make sure that the inspection results are valid. The aluminum tool 

provided with the Spyne can be used for this purpose. 

To proceed to the probe functionality check: 

I)   Once the probe setup is loaded in Magnifi, click on Cal. Check in the Calibration tab. The 
Calibration Check window will open, and some scan parameters (filters and encoder-based 
acquisition) will be disabled temporarily to perform the check. 

II)   Set the Spyne flat, upside down on a stable surface, with the probe facing up. 

III)   Null the probe in this position and start an acquisition. 

IV)   Place the nose of the aluminum tool in the long groove, at one end of the scanner, as 
displayed in Figure 12. Slide the tool gently along the length of the ECA probe by making 
sure that its nose stays in the groove the whole time. The eddy current sensors will react 
to the presence of the aluminum and will produce a characteristic signal in the C-scans. 

 

Figure 12. Probe functionality check with the nose of the aluminum tool inside the long groove. The 

aluminum tool is sliding along the entire length of the ECA probe, causing a signal response from each of 

the probe’s sensor. 

V)   Stop the acquisition. Both the axial and transverse C-scans should display a diagonal signal 
similar to Figure 13. The orientation of the diagonal line does not matter, it depends on the 
direction of the aluminum tool during the acquisition. 

VI)   Check both the F1A and F1T boxes and click Check. Two green check marks will show that 
all axial and transverse channels have acquired a signal from 
the aluminum tool, and that no sensor is damaged. 
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Figure 13. Example of diagonal-shaped signal obtained from the probe functionality check. 
 

VII)  This data cannot be saved, but a screen capture can be saved with Capture . This will 
create a .png file named CalCheck in the current inspection folder. 

VIII)   After completing these steps, the Calibration Check window can be closed, which will 
reenable the filters and encoder-based acquisition. 

Instead of using the aluminum tool, a calibration sample with a long EDM defect can be used to 

validate the uniformity of the probe: this is a calibration check. In this case, stricter settings can 

be applied to ensure that the signal amplitude and phase of all channels lie within a certain 

tolerance that is conform with the inspection procedure (for example, all channels within 5.0 ± 

0.5 V and 60 ± 5 °). This can be adjusted in the Edit Settings menu of the Calibration Check window. 

If necessary, the global amplitude and phase of the signal can also be tuned: 

o To modify the amplitude of the signal, modify the gain in the Data menu ____ of the 

Setup tab. This will apply a uniform gain to all channels of the probe. 

o To modify the phase of the signal, rotate the signal by 

dragging the rotation button up or down in the Lissajous 

window. This will apply a uniform rotation to all 

channels of the corresponding C-scan. 

Note that if the probe functionality check (or calibration check) is 

done after modifying the global amplitude, phase or eddy current 

frequency, the tolerance settings may need to be modified as 

explained above, in order to be kept consistent with the new setup 

parameters. 

Signal 

rotation 

button 
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6. Acquisition 

6a. Nulling the probe 

Before starting any acquisition, the Spyne probe must be nulled on a defect-free portion of the 

pipe. Below is a procedure to find a suitable area to null the probe: 

I) Put the Reddy in Setup mode, so that no data gets saved automatically. To do so, make 

sure that the Setup Mode button in the Home tab of the Frontstage is greyed out. 

II) Disable the median high-pass filters by going in the Setup tab, clicking on the Process 

 button, and unticking the two boxes next to the median filter values. 

 

III) Place your Spyne at a location where no visible defects are present. 

IV) Null your probe at this spot. 

V) Start an acquisition. 

VI) Move the Spyne around the identified spot. 

VII) Stop the acquisition. 

VIII) Look at the data: if the C-scan is green, that is a good place to null. If not, find another 

spot and repeat steps III-VII. 

IX) Mark the chosen null spot on the pipe if desired. 

X) Disable Setup mode. Do not re-enable the filters. 

6b. Multi-pass with circumferential encoder 

This section presents the recommended scanning method that benefits from the circumferential 

encoder. For alternative methods that don’t require the circumferential encoder, refer to 

sections 6c or 6d. 
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Before starting the acquisition, verify if severe corrosion or dents are present. If so, install the 

curvature stiffener on the Spyne before starting the acquisition (see section 1a). Also, make sure 

that magnetic wheels are installed on the Spyne. If not, the use of the circumferential encoder is 

not recommended. 

To perform a multi-pass acquisition using the circumferential encoder: 

I) Null the probe  on a clean section of the component being inspected (see section 

above). 

II) Place the Spyne at the beginning of the first corridor, with the front wheels behind 

the axial start line and the pointers aligned with the scan line. 

III) Make sure that the four wheels around the circumferential encoder module are well 

in contact with the pipe. 

a. It is recommended to keep one hand on the module while scanning to ensure good 

contact throughout the scan.  

IV) Start the acquisition and push the Spyne axially along the surface to inspect until the 

back wheels have passed the axial end line. 

V) Click on the Pause button on the Spyne keypad. 

VI) Place the Spyne at the beginning of the second scan corridor (see ). 

a. If the Comb mode was selected (default for multi-pass scans with circumferential 

encoder), place the front wheels behind the Axial start line. 

b. If the Raster mode was selected (alternating scan lines), place the back wheels 

behind the Axial end line. 

VII) Verify that the scan direction of the next pass corresponds to that indicated by the 

green LED on the keypad. 

VIII) Repeat step III. 

IX) Click on Pause to resume data acquisition and scan the second corridor. Make sure 

that the Spyne stops moving right after the back wheels pass the axial end line. 

X) Repeat steps IV-IX until you reach the end of the last scan corridor. 

XI) Stop the acquisition. 

All these actions can also be performed directly with the Spyne keypad (see section 0). 
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Figure 14. Example of multi-pass unidirectional data acquired with the circumferential encoder. Note the 

different scan lines corresponding to different passes. 

Important notes 

• The circumferential encoder will automatically record the X and Y position during the scan. 

If, between two passes during scan acquisition, a black area is visible on the C-scan, it 

means that this area was not covered by the scan. 

o The following pass can be used to re-scan this corridor and cover the missing area. 

Make sure to re-scan the whole corridor. 

• Make sure that the four wheels around the circumferential encoder are always well in 

contact with the pipe surface. Otherwise, recording of the circumferential position will be 

inaccurate. 

• Make sure that magnetic wheels are installed on the Spyne. 

• Avoid placing the circumferential encoder directly on longitudinal welds with a cap, such 

as seam welds. This will affect the tilt angle of the circumferential encoder and lead to 

inaccurate data positioning in this area. 

• If generalized corrosion is present on the pipe, make sure that the curvature stiffener is 

installed before starting the scan (see section 1a). 

• If a spiral weld is present on the pipe, or if the pipe is ovalized, the use of the 

circumferential encoder is not recommended.  



 

30 | P a g e  

6c. Single pass 

In this mode, each axial scan will be recorded as a separate data file. The only relevant parameter 

is the scan length (X-axis), which can be modified in Setup → Scan. With the default resolution of 

1 sample/mm (25 samples/inch), the maximum scan length for a single data file is approximately 

100 meters (4000 inches). 

 

Figure 15. Clockwise scans with the pointer on the left side. The pointer at the front of the Spyne follows 

the 0° line during the first pass and follows the next bottom line during the subsequent passes. 

To perform a single-pass acquisition: 

I) Null the probe  on a clean section of the component being inspected (as much as 

possible free of visible defects, corrosion, etc.) 

II) Place the Spyne on its start position (see figure above) 

III) Start the acquisition and push the Spyne axially along the surface to inspect 

IV) Stop the acquisition 

All these actions can also be performed directly with the Spyne keypad (see section 1a). 

If the maximum scan speed was exceeded during the inspection and data was missed, black 

vertical lines will be visible in the C-scan. Without stopping the acquisition, the Spyne can be 

moved back to the area with missed data to remove the black lines. 

Depending on the selected acquisition preference, the next data file can be selected 

automatically after stopping the acquisition, to facilitate the efficient acquisition and recording 

of multiple data files. 
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Figure 16. Example of a single-pass data file. The height of the C-scan corresponds to the probe coverage, 

with the bottom of the C-scan always corresponding to the cable side of the Spyne. 

6d. Multi-pass comb with manual increment 

To switch between the single pass and multi-pass acquisition modes, go to Setup → Scan. In 

multi-pass mode with manual increment, two parameters become relevant: the scan length in 

the X-axis, and the scan length in the Y-axis. To set the appropriate circumferential scan size in 

the Y-axis, refer to the table in section 2b. 

Note that with the Spyne, the multi-pass scan needs to be done in a clockwise orientation (from 

left to right, Figure 15). As a result, in Magnifi, the first pass will always be displayed at the top of 

the C-scan. 

To perform a multi-pass acquisition: 

I) Null the probe  on a clean section of the component being inspected (as much as 

possible free of visible defects, corrosion, etc.) 

II) Place the Spyne on its start position, behind the axial scan line. 

III) Start the acquisition and roll the Spyne axially along the surface to inspect 

IV) Take the Spyne off the surface and place it at its start position for the next pass  

V) In the Home tab, click on Next Pass  

VI) Repeat steps III, IV and V for every scan pass 
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VII) Stop the acquisition 

 

All these actions can also be performed directly with the Spyne keypad (see section 1a). 

The Previous Pass button  can be used to re-acquire a previous pass. 

 

 

Figure 17. Example of data file with manual increment, which each pass displayed on top of each other 

in a single C-scan. 

 

When analyzing large multi-pass scan data, it may be helpful to switch to a layout with a single 

C-scan instead of two. This can be done by clicking on Layout → Select. This will double the size 

of the C-scan on the screen.
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Limitations 

The data acquisition with the Spyne is subject to the following limitations: 

o The maximum scan speed is limited to 1200 mm/s (48 in/s). If the operator wishes to 

limit the scan speed to a lower value, it can be modified in Setup → Scan. 

o As explained before, with the Spyne’s default scan resolution of 1 sample/mm (25 

samples/inch), the maximum scan length for a single pass is approximately 100 meters 

(4000 inches). For multi-pass scans, the maximum scan length will depend on the pipe 

circumference. 

o The C-scans are built assuming a continuous scan. While scanning, make sure to keep 

the axial encoder wheel in contact with the surface. Missing counts from the encoder 

will result in an unscanned area and an inaccurate positioning of the indications. 

o If the component being inspected does not allow using the axial encoder wheel, clock-

based acquisition can be selected in Setup → Scan. In this case, the scan speed needs 

to be kept as accurate and constant as possible to allow locating the defects on the 

surface. 

o If the encoder wheel wears out over time and its diameter changes, the measured 

distance can become inaccurate. To workaround this issue, the encoder can be 

calibrated as presented in section 9 of this user guide. Alternatively, since the encoder 

is detachable, a new one can be purchased from Eddyfi. 

o The Spyne is designed to inspect relatively smooth surfaces with limited irregularities. 

Irregularities such as axial and transverse welds, corrosion, sharp bending, flanges, etc. 

can cause additional lift-off during the acquisition. It can also affect the movement of 

the circumferential encoder and cause positioning errors of the detected indications. 

By design, the circumferential encoder has its own tolerance on positioning accuracy. 

It varies based on the pipe circumference and corresponds to the largest value between 

1 degree and 10 mm (0.4 in). 
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7. Analysis and reporting 

7a. Indications merging criteria 

Immediately after the acquisition is stopped, the C-scan will display yellow boxes around all the 

indications detected, based on the signal threshold set previously. 

Before adding all the indications to the report, it may be relevant to review the boundary criteria 

for merging indications close to each other. For example, in most situations, it would be irrelevant 

to report dozens of separate indications within a single colony of cracks. Merging all these small 

indications into a single indication would be more appropriate and would lead to a lighter report. 

This is also more consistent with how magnetic particle inspection is performed. The boundary 

criteria for the X and Y axes can be modified in the Detect Indications menu. By default, one 

sample in X corresponds to 1 mm (0.040”). For example, setting the X boundary criterion to 25 

samples means that two indications within 25 mm (0.100”) of each other in the X axis will merge 

together. 

In the Y axis, one sample corresponds to 3.1 mm (0.12 in) for probes with 66 coils, and to 2.4 mm 

(0.09 in) for probes with 86 coils. If the circumferential encoder is not used, this value is divided 

by two due to interpolation between the channels. 

 

Figure 18. Effect of the X and Y boundary criteria on the number of indications displayed in the C-scans. 

Optimizing the boundary values will have a direct effect on the relevance of the report.  
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7b. Data analysis 

To facilitate data analysis, the following tools are also available in the Analysis tab: 

o The Previous  and Next  buttons are used to navigate between the different 

indications in the C-scans, based on their position on the X axis. If a laptop with Magnifi 

CPN is used for data analysis, by default, the keyboard shortcuts for Previous and Next 

are F7 and F8. 

o To add an indication to the report manually, use the Add defect  buttons at 

the bottom of each Lissajous view. This will add a grey indication box in the 

corresponding C-scan, where the cursor is located. In addition to the X-Y position of the 

indication in millimetres (or inches), the amplitude (V) and phase (°) of the eddy current 

signal measured in the impedance plane will also be reported. The option to take a 

screenshot for every indication added manually is available in the backstage: these 

screenshots can also be added to the report. 

Note that the automatically detected indications, represented by the yellow boxes in 

the C-scan, are not automatically added to the report. 

• The following indication codes are available by default in Magnifi: 

 

To add other indication codes, in the Setup tab, click on the Indication  

button. 

• More information on how to discriminate different types of indications is 

available in the Eddyfi Academy and is discussed in depth during the Spyne 

hands-on training. 
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o The No Defect  button is used to tag a data file without any indication.   

o The Review  button is used to tag a data file for further review. 

o The Add Note  button creates a .txt file attached to the data file currently loaded. 

o The Capture  button takes a .png screen capture attached to the data file 

currently loaded. 

The list of indications added to the report can be accessed by clicking on the Report tab at the 

bottom of the screen. 

 

You can also associate pictures of the region of interest by using the Eddyfi App, available for iOS 

and Android. Refer to the Connectivity tab of the backstage for more details. 

 

Special considerations when using the circumferential encoder 

• When analyzing a datafile acquired with the circumferential encoder, it is important to 

note that the C-scan is not interpolated, reducing the visual resolution along the Y axis. 

This only affects the visual of the C-scan and has no impact on the data acquired by the 

probe. 

• If, during the scan, the circumferential encoder was in poor contact with the pipe surface, 

or if it was used on a pipe with major corrosion without the curvature stiffener, the data 

may be positioned at a wrong angular value. 

In this case, automatic detection boxes may appear in regions where no defect seems to 

be present: 
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This is a symptom that, in the overlap region, the circumferential encoder was not in good 

contact with the surface during the final pass, resulting in a positioning error and erasing 

the indications detected during a previous pass. 

Keep in mind that data from the previous pass is not lost. By default, the Spyne setup 

shows only the data acquired in the final pass. To show the data acquired in the first pass, 

click on the C-scan name and select First: 

  

By comparing the two C-scans (A Final and A First), it is possible to see that some 

indications were detected in the first pass, but were later erased during the final pass. 

Regardless of which pass caused the detection, indication boxes will always appear in all 

C-scans: 
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7c. Generating the report 

For Spyne and ECA in general, Magnifi offers two types 

of report format, available in the report’s Table Profile 

option in the backstage: 

o Surface Screening: ideal format for the 

indications reported with the automatic detection tools (i.e. the Report Detections 

button). The screening report contains the position and size (X and Y) of each indication. 

o Generic Array: ideal format for the indications reported manually (i.e. with the Add 

defect buttons). The generic array report will contain the position (X and Y), signal 

amplitude (V) and signal phase (°) of each indication. 

Once the table profile has been selected, click on Generate Report  to generate the report. 

After selecting the report options and filling out the information contained in the report summary, 

the report will be created in the background, in .html format.  

The file will be saved in the inspection folder, which can later be transferred through wi-fi or USB 

by clicking on Transfer Inspection. The Reddy can also be connected to a OneDrive account. In 

this way, all files are automatically saved and synced to the cloud. Refer to the Connectivity tab 

of the backstage for more details.  

The report can be displayed only when transferred to a laptop, by double-clicking on it. 
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8. High-pass median filters 

The high-pass median filter is a powerful tool that increases the signal-to-noise ratio of ECA data 

and facilitates crack detection. However, if used the wrong way, it can filter out certain defects 

and make them invisible in the C-scan. 

The high-pass median filter can be tuned in the Process menu  of the Setup tab. 

The Index Axis value is used for two-dimensional median filters, which are rarely beneficial for 

the detection of surface-breaking 

defects such as cracks and pitting. 

For this reason, the Index Axis 

should be kept to its default value. 

The important tunable parameter of the high-pass median is the Scan Axis value. A widely used 

rule of thumb is to set this value to three times the longest expected defect. For example, in the 

presence of stress corrosion cracking colonies that can be as long as 100 mm (4 inches) in the 

scan axis, a filter of 300 mm (12 inches) should be used. Since it is often difficult to predict the 

size of the defects before an inspection, the length of the median filter should initially be kept to 

a high value. 

In summary, as displayed in Figure 19 below, an excessively long filter will not be as efficient in 

removing the background noise, but an excessively short filter will remove part of the signal from 

the defects. 

After data has been acquired, clicking on Lift-off Assist. in the Calibration tab will temporarily 

disable all median filters. This can be used as a quick on/off filter toggle. 

 

Figure 19. Effect of the size of a high-pass median filter on data quality: a) no filter causes a higher 

background noise (dark horizontal lines) and the smaller indications in the top right corner being missed; 

b) an optimal filter size provides an enhanced signal-to-noise ratio for indications of all sizes; c) a filter 

that is slightly too short removes parts of large indications without affecting their detectability; d) a filter 

that is significantly too short removes most of the indications and leads to defects being missed entirely. 

Do not modify Tunable length 
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9. Axial encoder calibration 

If the axial encoder wheel wears in time, its diameter can change and affect the encoder’s 

resolution. This will in turn affect the length measurement and positioning of indications and 

might distort the transverse C-scan (i.e. causing a straight transverse indication to appear with a 

zigzag shape in the transverse C-scan). 

To workaround this issue, a simple calibration can be performed to apply a correction factor to 

the encoder’s resolution: 

I)  Start an acquisition. 

II)  Roll the Spyne in a straight line on a flat surface and stop the acquisition. A longer travel 
distance will lead to a more precise calibration. 

III)  Measure the traveled distance precisely. 

IV)  In the Calibration menu, click on the Encoder  calibration button. 

V)  Enter the measured traveled distance and click Enter. 

VI)  Click Calibrate and click OK. The correction factor is now applied to the setup configuration. 
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10. Lift-off rotation (recommended for non-ferromagnetic alloys only) 

The following steps should be performed on the component under examination before beginning 

the inspection, to ensure that the phase of the eddy current signal is adjusted properly. This will 

help decreasing the inspection noise caused by lift-off and surface imperfections (i.e. corrosion, 

paint, dirt…) and will ensure that the defects have an orientation that will optimize their 

probability of detection. 

I)  Click on Lift-off Assist. in the Calibration tab. The Lift-off Assistant window will open, and 
some scan parameters (filters and encoder-based acquisition) will be disabled temporarily 
to perform the lift-off adjustment. This will also modify the Lissajous windows temporarily 
to display the impedance signal of multiple channels simultaneously. 

II) Put the Spyne on a clean section of the surface under examination. For optimal results, the 
surface should be as clean as possible (free of cracks, corrosion…) and representative of the 
rest of the surface being inspected. For example, if the entire surface is coated, the Spyne 
should be placed on a coating of the same thickness. 

III) With the entire length of the Spyne in good contact with the surface, null the probe (default 
keyboard shortcut: F6). 

IV) Start an acquisition (default keyboard shortcut: F2). 

V) Slowly lift the probe in the air and stop the acquisition. If magnetic wheels are used, start 
by lifting both extremities of the scanner before lifting the entire body. 

   

Figure 20. Spyne lift-off calibration: 1) Null the Spyne on a clean section of the inspected surface, with the 

whole length of the probe in good contact with the surface; 2) Start an acquisition and slowly lift the probe 

in the air. 

1 2 
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Figure 21. Positioning of the C-scan cursor at the transition between the material and the air. 

VI) The figure above shows an example of axial C-scan and Lissajous obtained from the lift-off. 
Rotate the lift-off signal to have the beginning of the impedance curve pointing toward the 
left, around 0°, for each channel displayed. Depending on the amount of lift-off variation 
expected during the inspection (due to the level of corrosion, the uneven thickness of the 
coating, etc.), the curve can be rotated with its beginning pointing slightly upward, allowing 
the defect indications to have a higher phase at high lift-off values. See the example in the 
figure below. 

      

      

Figure 22. a) Typical lift-off signal orientation, with the beginning of the curve pointing strictly to the left; 

b) Rotation allowing the beginning of the lift-off curve to be oriented slightly upward; c-d) Typical signal 

of a crack indication in carbon steel for orientations a) and b) respectively, showing that orientation b) 

leads to a higher signal phase (higher vertical amplitude) that increases the probability of detection of 

defects at higher lift-off. 

VII) This data cannot be saved, but a screen capture can be saved with Capture . This will 
create a .png file named LiftOff in the current inspection folder. 

VIII)  After completing these steps, the Lift-off Assistant window can be closed, which will 
reenable the filters and encoder-based acquisition. 

Signal 

rotation 

button 

Indication at 

2mm lift-off 

Indication at 

no lift-off 

Both indications with high 

vertical amplitude 

a) b) 

c) d) 




